
Assignment 3 Floor Plan CAD Fundamentals I 
Due February 1  Architecture 411 

 

 

Objective 

To learn to draft precise architectural plan drawings. 

To gain experience with CAD drafting tools and techniques. 

Exercise 

 1. Come up with a floor plan for a residence to draft for this assignment.  The residence can be the 
house or apartment that you live in, or grew up in.  It can be an original design.  It can be a current 
or past studio project.  It can be your “dream home.”  It can be based on a famous building, like 
Palladio’s Villa Rotunda or Wright’s Robie House.  It can be a house from the Sunday paper.  It can 
be a floor plan from a web site, like <http://www.architecturaldesigns.com/>.  Make sure that you 
note who designed the building and where you found the plan. 

The building should be at least the size of a small house (at least 5 or 6 rooms).  However, it should 
be small enough that it takes up less than half (and probably less than 1/10) of a site that is about 
150’ by 250’.  Note that approximately 150’ by 250’ is the size of the site you will be given in the 
Site Plan assignment.   

A significantpart of your points for embellishment on this assignment will be based on the 
complexity of the floor plan you draw.  Buildings with more rooms/halls/closets or buildings with 
complex shapes (e.g., buildings with curved walls or wings that go off at non-orthogonal angles) are 
more difficult to draw, and such plans will be considered more “embellished” than small simple floor 
plans.  Note that repetitive and/or symmetrical buildings (e.g., an apartment building comprised of a 
single unit repeated or mirrored ad nauseam) will be considered only slightly embellished, because 
they are relatively simple to draw. 
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The floor plan you choose should include a patio, or should be such that you can add a patio to it. 
(See steps 8-9, below). 

Note that you will be graded on your mastery of CAD tools, not on your building design.  However, 
you may find the results more satisfying and presentable if your floor plan resembles a realistic 
design.  It might therefore be advisable to make sure that your rooms have windows, adequate 
closet space, and appropriate sizes.  As a few guides, a living room might be around 10’ by 12’ if it 
is very small, or it might be 18’ by 25’ if it is large.  It will almost never be 30’ by 40’.  A two-car 
garage is likely to be 20’ by 20’, plus or minus a couple feet. 

Make sure that you like the building you come up with, because you will be seeing a lot of it.  You 
will also be using it for the Symbols assignment, the Site Plan assignment, the Layers assignment, 
and the Dimensioning assignment (and probably the InDesign and HTML assignments, as well). 

If you wish, you can attempt to combine step 1 with step 4, designing the building as you sit at the 
computer. 

 2. Start a new drawing in AutoCAD. 

 3. Set up the drawing to use appropriate units, drawing limits, grids, snaps and other modes. 

  These settings will have to accommodate your floor plan, drawn at full scale. 

 4. Draft the floor plan.  An example is shown on page 1.  Do not draw the example.  Draw a floor plan 
that you came up with. 

  Note that the LINE, OFFSET, EXTEND, TRIM, FILLET, COPY, ROTATE, and MOVE commands 
will all prove useful for drawing the plan.  CIRCLE, ARC, BREAK, and STRETCH may prove useful, 
as well.  You can use the MULTILINE command, if you wish.  Use other commands as needed.  
Remember to save your work often. 

  Use grids, snaps, object snaps, object tracking, ortho mode, polar mode, and UCS’s as needed 
and as you find convenient. 

  Do not add doors, windows, furniture, or plumbing fixtures to the drawing for this assignment.  A 
library of such symbols will be provided later.  You should, however, leave gaps in the walls like the 
ones shown in the figure on the first page, for inserting doors and windows later. Openings for 
doors should be 32”, 36”, 48”, 60” or 72”. Openings for windows should be 30”, 36”, or 48”.  The 
walls containing doors or windows need to be exactly 4”, 6”, 8” or 12” thick. 

  Be neat and precise as you draw.  You will be counted off for walls that are not quite orthogonal, 
lines that don’t quite meet or extend slightly beyond where they meet, walls that get slightly 
narrower along their length, and other signs that you have not used drafting tools correctly.  

 5. Define new text styles.  You will need to define two new text styles, by going to  
“Format->Text Style…” in the pull-down menus.  This will bring up the dialog box below.  For each 
text style, you will need to use the “New” button and give the style a name.  You will also have to 
indicate the name of a font file (a “Font Name”) to use for each style, choosing one from the list 
box. 
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Make sure that you indicate a height of “0” for the height of text for the styles; this will allow you to 
specify text heights later, when actually adding text to the drawing 

 6. Use the DTEXT command to label each room with a name and a length and width.  In the Styles 
toolbar, make sure that one of the text styles you created is the current text style.  Then go to 
“Draw->Text->Single Line Text” in the menus, or type “DTEXT” at a “Command:” prompt. 

  You will be asked to indicate a location where the text will start. 

  You will need to specify a height for the text.  All your room names should have the same text 
height as each other.  Also, all your room sizes should have the same text height as each other.  To 
choose an appropriate text height, imagine that the text is an actual object lying on the floor of the 
room.  The size that the text would be if it was an object on the floor is the text height that you 
should use (probably somewhere between 6” and 2’). 

  You will also need to indicate a “rotation angle” for the text.  You want your text to be horizontal, so 
just use “0” for the angle. 

 7. Add information to the lower right corner of your drawing using the MText command.  You should 
indicate a name for the design, using the second text style you defined.  Also indicate the designer 
and/or where you got the floor plan.  If you found the floor plan in a book, magazine, newspaper, or 
web page, indicate the source.  Lastly, create MText saying “Drawn by: “ (or “Modified and drawn 
by: ” or “Design and drawing by: ” or some other appropriate phrase) followed by your name.  

  Use the MTEXT command (“Draw->Text->Multiline Text…”) to add this text.  You will need to draw 
a window around the area where you want the text to appear.  Note that no text will extend left or 
right of the window you specify (instead, the text will wrap to the next line), so make sure that you 
specify a window that is big enough. 

  After you specify the area for the text, a very limited text editor (shown below) will appear.  This lets 
you edit your text and how it is formatted.  In the crude window of the text editor, you can type/edit 
the text you want to add, or set the indentation and tab stops.  You can use the toolbar that appears 
above the crude window to change the formatting of the text. 
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  If you need to make any drastic changes to text size, AutoCAD may resist.  If it resists, try changing 
the text size in 2 or 3 smaller steps.  For instance, if AutoCAD won’t let you change the text height 
from 3/16” to 2’, try changing it from 3/16” to 3”, then from 3” to 2’. 

 8. Create and plot a tile to use in the patio.  Draw the tile somewhere over to the side, away from the 
rest of your drawing.  Draw a modular tile that can be repeated many times in a pattern to create a 
patio.   

  Plot the tile on a separate sheet.  In the Plot dialog box, specify “Window” for “What to plot”, then 
draw a window around your tile.  Everything within the window you specify will be plotted, so 
specify a window that is only slightly larger than the tile.  Specify “Fit to paper” for the plot style. 

  Be sure to write your name on the plot (it is OK to just write your name in pen on this sheet). 

 9. Use the ARRAY and COPY commands to cover a patio with this tiling pattern.  

  Draw lines around the perimeter of your patio.  You will later use these lines for TRIMming.  Don’t 
specify a plain rectangular perimeter; instead, draw a perimeter that has one or more corners 
beveled off, or one that has a semicircular protuberance from one side, etc.  Choose a shape that 
can not be filled neatly with a rectangular array of tiles. 

  MOVE the tile to the lower left corner of the patio area. 

  Use the ARRAY command to fill the patio area with tiles.  You should create a rectangular array, as 
shown below.  Since your patio is not rectangular, the array will not fill the patio neatly, and some 
additional editing will be required. 
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  You will need to indicate the “offsets” between the rows and columns in the array.  Note that 
“column offset” is not the gap between the right side of one column and the left side of the next; it is 
the horizontal distance between the places where the pattern repeats.  Tiles that are supposed to 
touch each other should have offsets equal to the width and length of the tile. 

  Use the COPY command (and perhaps the ARRAY command again) to fill any parts of the patio 
that extend beyond the bounds of the original array. 

  Use the ERASE and TRIM commands to edit tiles that overlap the edges of the patio.  (Having a 
beveled corner or protuberance should ensure that you have to do this in at least one place.) 

 10. Alter lineweights appropriately in your drawing.  This can be done by selecting lines, arcs, etc. in 
the drawing (use windows or crossing boxes to select more than one at a time), and then going to 
the lineweights listbox in the properties toolbar (see below). 

 

  Specify a lineweight of 0.00mm for the patio tiles; this will cause the printer to use the thinnest line it 
can print.  Specify the same size or a little wider (0.00-0.09mm) for the text, and specify 0.30mm for 
the walls.  
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  Depress the “LWT” button on in the Status Bar (at the bottom of the AutoCAD window frame), so 
you can preview the effect.  Some of the line widths that you will see may be exaggerated, so the 
view you see will not necessarily be completely accurate.  Still, depressing the “LWT” button is 
good for letting you know whether you have forgotten to change the lineweights of any of your lines. 

  Caution:  Lines that have “Default” lineweight are not always displayed correctly on the 
screen.  When plotted, “Default” lineweight lines will have lineweights determined by the current 
value for the default lineweight.  (This is set via “Format->Lineweight…” in the menus).  However, 
AutoCAD sometimes draws such lines on the screen as if they had zero-lineweight, even when the 
default value is much higher.  Therefore, you will need to carefully check the lineweights in 
your plots.

  When you are done viewing lineweights on the screen, leave the LWT button depressed, or turn it 
off, whichever you prefer. 

 11. Embellishment/additional work. 

  As mentioned previously, more complicated floor plans will count as “embellishment” on this 
assignment. 

  For additional points for embellishment, use two tile patterns, perhaps alternating the tiles.  You can 
also create two patios, or use a tile pattern for the floor in the kitchen or bathroom.  (Use the 
thinnest line weight for floor tiles – “0.00mm”). 

  You can also draw a floor plan of a second story or of an alternate design scheme as 
embellishment/additional work.  Any additional plans are best done as separate drawings.  If you 
draw an extra floor plan that is a modification of the original (or a second story that fits on top of the 
original), save your original floor plan under one name, then save it again under a different name 
and begin modifying it. 

  If you wish, you can try to poché walls (i.e. fill them with a solid color) by hatching them with the 
“SOLID” pattern.  This can require some patience and a bit of luck.  WARNING: Never try to create 
a solid tone by doing very tiny hatching, as this can make AutoCAD unmanageably slow.  If you 
poché your walls, you should use a grey color for the solid hatch, so that your lines will still be 
visible.  You should experiment on your own or consult the AutoCAD help to find out how to change 
colors. 

  Plot any additional tiles or floor plans you create (see step 12).  Plot any additional tile designs one 
per page by plotting a Window (for “What to plot”) and using the “Fit to paper” setting in the plot 
dialog box (as in step 6).  Plot additional plans as in step 12. 

  Do not bother drawing doors, windows, plumbing fixtures, appliances, furniture, or trees as 
embellishments.  These objects will be added to the drawing in later assignments.  However, you 
may wish to draw stairs (consider using the ARRAY command for these), railings, kitchen cabinets, 
built-in shelves, or other built-in custom furnishings. 

  In all cases, the extra items must be drawn accurately. 

  As always, save your work before experimenting with new commands. 

 12. Save your work and plot the finished floor plan. 
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Standard architectural scales are 1”=1’, ¾”=1’, ½”=1’, 3/8”=1’, ¼”=1’, 3/16”=1’, 1/8”=1’, 
3/32”=1’, and 1/16”=1’.  Standard engineering scales are 1”=10’, 1”=20’, 1”=30’, 1”=40’, 
1”=50’, 1”=60’, 1”=100’, 1”=200’, 1”=300’, 1”=400’, 1”=500’, and 1”=600’.  One should 
always choose a scale such that the drawing is as large as possible, while still fitting in 
the available space on the page.  Large architectural scales, like 1”=1’ or 3/8”=1’, are 
not commonly used for floor plans, but may be used for detail drawings that show how a 
wall is constructed, show a particular beam-to-column connection, etc.  Small 
engineering scales, like 1”=500’, 1”=100’, or even 1”=40’, are seldom used for floor 
plans, but may be used for site plans. 

  Plot at a standard architectural or engineering scale.  You will be counted off if your floor plan is not 
plotted at one of the above scales.  Work in subsequent assignments must also be plotted at one of 
the above scales, unless specifically stated otherwise.   

  Make an appropriate choice for “What to plot” (“Limits”, “Window”, “Extents”, etc.) and choose an 
appropriate scale from the “Scale” listbox under “Plot scale”.  Use either 8.5”x11” or 11”x17” paper. 

  Do a full plot preview of the drawing to verify that all of your settings are correct.  Correct any 
problems with plot settings, and plot the drawing.   

  Make sure that the lineweights are correct in the finished plot.  If they aren’t correct, go back to step 
10 and fix them. 

  In pen or pencil, write the scale you used for plotting on the floor plan plot.  Points will be deducted 
if you do not do this. 

 
What’s due: 

A plot of a patio tile, fit to paper (step 8). 

A floor plan, with room names and sizes, plotted at a common architectural 
or engineering scale—probably 1/4”=1’, 3/16”=1’, 1/8”=1’, or 
3/32”=1’, 1/16”=1’, or 1”=20’ (step 12).  The plot scale should be 
written somewhere on the sheet. 

Any additional floor plans or tiles you create for embellishments (step 11). 
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